
Introduction

Thank you for using BackupOnline.com, your first step on the road to hassle-free, 
secure backups.

Every PC and system user at one time or another has more than likely had to deal with a 
hard drive that has crashed, tapes and discs that have gone astray or computers that have 
disappeared silently in the night taking with all important data that then has to be 
recaptured etc. This exercise is one of extreme frustration and time wastage.

BackupOnline.com offers a cost effective and easy to use solution to this major problem –
automatic scheduled backups of all your important files – taking the onus off you of having 
to remember to do backups as well as eliminating the time wasted in doing so.

Security is the most important issue when storing data. BackupOnline.com is completely 
secure as all data is encrypted using 448-bit blowfish algorithm. This encryption power is 
three times that used by banks and considerably greater than the United States government
will allow foreign users to apply – because it is beyond the ability of its security agencies to 
eavesdrop. Your data is compressed and encrypted at your home site so that in the unlikely 
event that it is intercepted by a third party, it remains totally secure. Each subscriber has 
their own encryption key, which is necessary to decrypt data. The encrypted data is stored 
offsite at multiple disaster-proof sites and is fully protected from fire, floods, theft, etc. 

BackupOnline.com is extremely simple to use – you choose when you want the backup 
process to take place i.e. the day and the time, and the backup will happen automatically 
then i.e. every hour, at 16h00 every day, once a week etc. Only new and changed files are 
copied to the site. You can create multiple backup sets that can each have their own unique 
backup schedule – so no more forgotten backups. BackupOnline.com will not let you shut 
down your computer without prompting you to do your backup (if selected).

You have unlimited backups and restores available to you and you have a choice of doing 
this via your Internet connection or by means of direct dial-up. Using your personal 
encryption key, you can retrieve data from any computer with a modem. The service is 
available 24 hours a day, 7 days a week to store and retrieve data files accurately and 
securely. There is no charge to retrieve data from your secure account. You can also define 
how long you wish to keep backups before they expire and are discarded. Archived backups 
are also available on CD-Rom to the subscriber, on request, free of charge.



Requirements
 Minimum System Requirements

      To use BackupOnline.com you will need:
486 Processor or higher

16 MB RAM
28.8 Kbps or faster Modem
Internet access or direct dial-up if you are in an area where we have a Point-
of-Presence
Windows 95, 98 or NT4.0



Options Wizard

Click on the Options button.    This will start the Options Wizard.
Click Next

1) Preferences
-Ensure that there is a tick in the corresponding boxes for:

Enable Scheduled Backups
Run at Startup
Keep Log Files

Also, the maximum log file size should be set at 512K.
Click Next.

2) Encryption Key

-Insert an Encryption Key in the New Key Field and retype it in the Confirm Field
If you want to change your encryption key at a later stage, you will be prompted to 
insert the old key before you can do so.

(WARNING: - DO NOT FORGET YOUR ENCRYPTION KEY. YOU ARE THE ONLY ONE 
THAT HAS THIS INFORMATION.    IF YOU FORGET YOUR KEY, BACKUPONLINE 
STAFF CANNOT HELP YOU GET IT BACK, AND YOU WILL NOT BE ABLE TO DECRYPT 
YOUR BACKUP FILES.    ALSO, BE CAREFUL OF CHANGING YOUR KEY FOR THE SAME
REASON. MAKE A NOTE OF YOUR KEY AND KEEP IT SOMEWHERE SAFE.)

Click Next

3) Compression
-Set the Compression Type to Slowest (Maximum
Compression)
-Set the working folder to a temporary folder of your
choice. This does not have to be on the same hard drive    
as the client software. The default folder is      
the folder in which Backuponline was originally installed

Click Next

4) Modem

 Make sure there is a tick in the corresponding boxes for:

Reconnect Automatically; and
Disconnect When Finished

Set the Number of Redials and the Number of Minutes between Redials to not less
than 5.

Click Next

5) Transfer



If you are using an Internet connection, set the Transmit Size to 3072
and the Receive Size to 3072
You can also give the transmit and receive threads different priorities, increasing the 

performance of the communications.

Click Next

6) Shut Down
-Make sure the Prompt for Backup Before a Shut Down is checked
-Set the Default Shut Down Mode and Timeout to the preferred settings

Click on Next

7) Notification

If you would like to be notified once your backup has been sent correctly,
Select the check box next to - Send an e-mail Notification and insert your e-mail 
address in the field below it

You can also receive an SMS message on your Mobile phone (provided your mobile 
network caters for this facility).
Select the check box next to - Send an SMS Notification and insert your mobile number
in the field below it

Click Next

Make sure all the settings are correct in the summary window.

Click Apply



Billing
To start the Billing Wizard, Click on the Setup menu.
Click on Billing.

Select which payment option you would like to use (If you are outside of South Africa, only Credit Card 
payments can be selected).
Click Next

Insert the Credit Card details or Bank details in the correct fields.
Click Next.

Check that your details are correct in the summary.
Click Apply.



Registration
To start the Registration Wizard,

Click on the Setup menu
Click on Registration
Select Free Trial Period, or if you have already been assigned a Registration Number by 
Backuponline, select Enter Registration Number.
Click Next

Insert a Login Name and Password you would like to use.
This name will automatically be verified by the Backuponline servers to make sure that it is 
available for you to use.    If it is not available the software will prompt you to try a different 
login name.
Click Next

Fill in your contact information
Click Next

Select your Country
Insert a Postal or Physical Address
Click Next

Check your details in the summary
Click Apply



Connection Wizard

To start the Connection Wizard, Click on the Setup menu and Click on Connection.

Select Direct Connection to a Server if you are connecting to a local LAN server or if you are connected
to the Internet via a leased line.
Click Next
The Host Name for the Backuponline Server should be 216.0.50.3 and the Server Port 211
Click Next
Click Apply

Select Use an Existing Dial-up Connection if you already have an Internet access account with an ISP.
Click Next
Select the Dial-up Networking connection you wish to use.
Click Next
The Host Name for the Backuponline Server should be 216.0.50.3 and the Server Port 211
Click Next
Click Apply

Select Create a New Dial-up Connection to create a new dialup connection to an ISP or to 
Backuponline directly if you are in a region where we have a Point-of Presence.    

If you would like to connect directly to backupOnline.com (highly recommended), do the 
following:

Click on Next
Type the name BackupOnline in the Name field
Make sure you have your Modem selected in the Device field
Click the Next button
Type in the Area Code 011 and the Telephone Number 778-7500
The Country Code must be South Africa (27)
Click Next
Click Finish



Backup Wizard

1) To start the Backup Wizard, 
Click on the Backup button or click on the Actions menu and then Backup 
Select Create a New Backup
Click Next

2) Give the backup a Name
Select None in the Append Backup Field, unless you wish to create an incremental 

backup.    
If you do, select the name of the backup you want to append to in the Append Backup 

field

You can expire your backup after a certain number of days. If you do insert an expiry for
your backup, it will be deleted from the server after the number of days that you have 
specified.    To enable this feature, select the check box next to Expire After, and specify the 
number of days (This function can only be used for full backups and will be disabled for 
incremental backups).

If you are using an existing backup set, you can select Re-use Existing File List. This will 
display the last file list that you created.

Click Next

3) You can now add any files and/or folders you wish to.
Hold down the Ctrl or Shift key to select multiple files or folders.    By Clicking on the 

right arrow button next to the Mask Field, you can specify which types of files you want to 
select in specific folders.    You can also add these masks by replacing the *.* with the file 
extensions of the files you wish to back up, separated by a comma, semicolon or space. eg 
*.doc, *.xls, *.mdb.

You can click on cancel to get to the Backup Files Dialog where you can:
Add files by clicking the Add button.
Remove files by selecting the file(s) and clicking the Remove button

You can also use Drag and Drop to select files
Click on the Options Menu
Make sure that Stay on Top is selected. If it is not, click on it
Click on the Explorer button.    This will bring up Windows Explorer
Click on the shrink button.    This will allow you to see the whole of the Explorer and give 

you a small block to drag your files or folders to.

Once you have selected all the files and folders you wish to backup, click the Apply button.   
If you have shrunk Backuponline, the Apply button is the one with a picture of a floppy disk.

Click Yes to save the session.
Click Apply.

The files you have selected will now be compressed and encrypted.    You can send the 
backup when this process is complete by leaving the Send Backup When Complete checkbox
ticked, and Clicking OK.
To send the backup to the Outbox and send it at a later stage, remove the tick and click OK.

To send backups that are in the Outbox:



Select the backup you wish to send from the Outbox
Click on the Send/Receive button
Or
Click on the Backup button or Click on the
Actions menu and then Backup (this will start the Backup Wizard)
Select Send/Receive 
Click Next
Click Apply.



Restore Wizard
Restoring Files

Restoring files is even easier than backing them up

To start the restore wizard,
Click on the Restore button

Select Restore Backup(s) From the Server 
Click Next

Check the backup(s) you want to restore
Click Next

Verify the details in the summary screen
Click Apply

The selected backup will now be downloaded from the server.

To Decompress and decrypt the backup that you have retrieved,
Click on the Restore button
 and a file list will be displayed so that you can select the particular files you wish to restore
Select the files
Click the Restore File(s) button to start the restore wizard

Select View / Extract Restored Backup.
Click Next.

Select the backup you wish to extract.
Click Next

Verify the details in the summary screen
Click Apply

A list of the files in the backup will be displayed.
Select which files you want to extract.
If you do not select any files, all files will be restored by default

Once you have clicked the Restore File(s) button, the files will be automatically decrypted,
decompressed and restored to their original locations or the location that you specified in 
the Other Path field.



Scheduler
Creating Scheduled Backup

To start the Schedule Wizard:

Click on the Schedule button; or Click on the Action menu and then Schedule.
Select Create a New Schedule
Click on Next

Give the Schedule a name
Click Next

Give the backup a Name
Select None in the Append Backup Field, unless you wish to create an incremental 

backup.    
If you do, select the name of the backup you want to append to in the Append Backup 

field

You can expire your backup after a certain number of days. If you do insert an expiry for
your backup, it will be deleted from the server after the number of days that you have 
specified.    To enable this feature, select the check box next to Expire After, and specify the 
number of days (This function can only be used for full backups and will be disabled for 
incremental backups).

If you are using an existing backup set, you can select Re-use Existing File List. This will 
display the last file list that you created.

Click Next

You can now add any files and/or folders you wish to.
Hold down the Ctrl or Shift key to select multiple files or folders.    By Clicking on the 

right arrow button next to the Mask Field, you can specify which types of files you want to 
select in specific folders.    You can also add these masks by replacing the *.* with the file 
extensions of the files you wish to back up, separated by a comma, semicolon or space. eg 
*.doc, *.xls, *.mdb.

You can click on cancel to get to the Backup Files Dialog where you can:
Add files by clicking the Add button.
Remove files by selecting the file(s) and clicking the Remove button

You can also use Drag and Drop to select files
Click on the Options Menu
Make sure that Stay on Top is selected. If it is not, click on it
Click on the Explorer button.    This will bring up Windows Explorer
Click on the shrink button.    This will allow you to see the whole of the Explorer and give 

you a small block to drag your files or folders to.

Once you have selected all the files and folders you wish to backup, click the Apply button.   
If you have shrunk Backuponline, the Apply button is the one with a picture of a floppy disk.

Click Yes to save the session.
Click Next

Select a Daily, Weekly. or Monthly schedule



Click Next

Daily Schedule
          Specify the time for the backup
          Click Next
          Click Apply
          
Weekly Schedule

Specify which day(s) of the week and at what      
time of the day you want the backup done

          Click Next
          Click Apply

Monthly Schedule
Specify which day of which month(s) and at what time of the day you want 
the backup done

          Click Next
          Click Apply.

Verify that the details are correct in the summary dialog
Click Apply

Running Scheduled Backups
    -      To run a scheduled backup, simply leave the computer on.        
            The scheduled backup will automatically run at the specified time
-        If you wish to shut the computer down, the BackupOnline Client Software will 
automatically ask you if you wish to make a backup before you do

    -      Click Yes (the backup wizard will automatically start)
    -      Select Run the Scheduled Backup
    -      Click Next
    -      Click Apply

              If you are running a machine with advanced power management capabilities, your 
machine will automatically shut down and switch off when the backup is complete.
              You can also run the scheduled backup by clicking the Backup button, selecting Run
the Scheduled Backup, clicking Next and then clicking Apply.



Disaster Recovery

I f you're looking at this page, it probably means your hard drive has crashed, your 
computer has been stolen, or some other disaster has affected your critical files. But that's 
why you're a subscriber to BackupOnline in the first place. 

We would like to help you get up and running again in the minimum amount of time. 

If you need to, download the latest version of the BackupOnline Client Software, then 
reinstall the BackupOnline Client Software to retrieve your files.

It doesn't matter whether you've repaired your original PC after a catastrophe, replaced it 
with a new PC or decided to use another available PC, you're just a few steps away from 
retrieving the critical files you've protected with BackupOnline. 

Before you begin to reinstall the BackupOnline Client Software, you should install and 
configure Windows. You'll also need to configure your Internet connection (including Dial-Up
Networking), so that the software will have a way of contacting BackupOnline where your 
files are stored. 

Once the Client Software is installed, you will need the following information for 
configuration. 

· Login Name 

· Password 

· Encryption Key 

The Encryption Key is specified by you when you first set up your BackupOnline Client 
Software. If you are missing any of this information, contact Customer Support. We can 
provide you with your Login Name and Password. 

NOTE: To ensure the security and privacy of the files you store, BackupOnline staff does not 
have access to your Encryption Key. 

The first step is to refresh the list of backup sets in the Sent Items Folder. 

· Open the BackupOnline Client Software window. 

· Click on the Options button to reconfigure the Client Software. 

· Select Actions from the menu bar and click on Download Settings. 

· Click on Retrieve. 

A list of all the files and folders you have stored in your account will be retrieved to the Sent
Items folder so that you can select the backups you wish to retrieve. 

To start the restore wizard,
Click on the Restore button

Select Restore Backup(s) From the Server 
Click Next



Check the backup(s) you want to restore
Click Next

Verify the details in the summary screen
Click Apply

The selected backup will now be downloaded from the server.

To Decompress and decrypt the backup that you have retrieved,
Click on the Restore button
 and a file list will be displayed so that you can select the particular files you wish to restore
Select the files
Click the Restore File(s) button to start the restore wizard

Select View / Extract Restored Backup.
Click Next.

Select the backup you wish to extract.
Click Next

Verify the details in the summary screen
Click Apply

A list of the files in the backup will be displayed.
Select which files you want to extract.
If you do not select any files, all files will be restored by default

Once you have clicked the Restore File(s) button, the files will be automatically decrypted,
decompressed and restored to their original locations or the location that you specified in 
the Other Path field.

If you have any questions or problems please contact our Customer Support and 
we'll do whatever we can to help.



Toolbar

There are three modes for viewing the toolbar:

Normal View – In the View Menu under Toolbar, both Standard buttons and Text 
Labels are selected.

Advanced View - In the View Menu under Toolbar, Standard button is selected.

No Toolbar - In the View Menu under Toolbar, neither Standard button nor Text 
Labels is selected.



Logs

 To view Log Files click on the Logs button

The Backups Log shows the details for each backup at the time of creation

The Restores Log shows the details for each restore at the time of decompression and 
decryption

The Internet Backups Log shows the details for each backup at the time of dialup and 
sending (this is also an      
indication of whether or not the backup was sent successfully)

The Internet Restores Log shows the details for each backup that has been successfully 
retrieved from the      
secure off-site servers at the time of dialup and retrieval (this is also an indication of 
whether or not the backup    
was retrieved successfully)

The Remote Access Log gives an indication of successful or failed dialups. This is used to 
troubleshoot the dial-in connection

The Registry Downloads Log keeps track of any live updates to the registry settings, e.g. 
host name, IP Address or Port Number

The Deleted Backups Log shows backups that have been deleted from the server.



Contact Details

If you experience any problems with the installation, contact our support centre for 
assistance.

For Technical Support, please contact:
Telephone: +27 11 485-4608/9/10
Fax: +27 11 485-4594
E-mail: support@backuponline.com 

For more Information contact:
Telephone: +27 11 485-4608/9/10
Fax: +27 11 485-4594
E-mail: info@backuponline.com




